
LabQuest


12

LabQuest 12

Static and Kinetic Friction


Static and Kinetic Friction

If you try to slide a heavy box resting on the floor, you may find it difficult to get the box moving. Static friction is the force that counters your force on the box. If you apply a light horizontal push that does not move the box, the static friction force is also small and directly opposite to your push. If you push harder, the friction force increases to match the magnitude of your push. There is a limit to the magnitude of static friction, so eventually you may be able to apply a force larger than the maximum static force, and the box will move. The maximum static friction force is sometimes referred to as starting friction. We model static friction, Fstatic, with the inequality Fstatic  s N where s is the coefficient of static friction and N is the normal force exerted by a surface on the object. The normal force is defined as the perpendicular component of the force exerted by the surface. In this case, the normal force is equal to the weight of the object.  

Once the box starts to slide, you must continue to exert a force to keep the object moving, or friction will slow it to a stop. The friction acting on the box while it is moving is called kinetic friction. In order to slide the box with a constant velocity, a force equivalent to the force of kinetic friction must be applied. Kinetic friction is sometimes referred to as sliding friction. Both static and kinetic friction depend on the surfaces of the box and the floor, and on how hard the box and floor are pressed together. We model kinetic friction with Fkinetic  = k N, where k is the coefficient of kinetic friction.

In this experiment, you will use a Dual-Range Force Sensor to study static friction and kinetic friction on a Dynamics Cart. A receiver will also be used to analyze the kinetic friction acting on a sliding cart.
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Figure 1

objectives

· Use a Dual-Range Force Sensor to measure the force of static and kinetic friction.

· Determine the relationship between force of static friction and the weight of an object.

· Measure the coefficients of static and kinetic friction for a particular cart and track.

· Use a Dynamic Cart to independently measure the coefficient of kinetic friction and compare it to the previously measured value.

· Determine if the coefficient of kinetic friction depends on weight.

Materials

	LabQuest
	Dynamics Cart and track

	LabQuest App
	balance or scale

	Vernier Dual-Range Force Sensor
	mass set

	string
	graph paper 

	
	


Preliminary questions

1.
In everyday life, you often experience one object sliding against another. Sometimes they slip easily and other times they do not. List some things that seem to affect how easily objects slide.

2.
Consider a box sitting on a table. It takes a large force to move it at constant speed. List at least two ways you could reduce the force needed to move the box at constant speed.

3.
In pushing a heavy box across the floor, is the force you need to apply to start the box moving greater than, less than, or the same as the force needed to keep the box moving? On what are you basing your answer?

Procedure

Part I  Starting Friction

1.
Measure the mass of the cart and record it in the data table. 

2.
Set the range switch on the Force Sensor to 10 N. Connect the Force Sensor to LabQuest. Choose New from the File menu. 
3.
Tie one end of a string to the hook on the Force Sensor and the other end to the bracket on the Dynamics Cart. Place a total of 1 kg mass on top of the cart, fastened so the masses cannot shift. Before you collect data, practice pulling the block and masses with the Force Sensor using a straight-line motion. Slowly and gently pull horizontally with a small force. Very gradually, taking one full second, increase the force until the carts starts to slide, and then keep the cart moving at a constant speed for another second.

4.
Sketch a graph of force vs. time for the force you felt on your hand. Label the portion of the graph corresponding to the cart at rest, the time when the cart just started to move, and the time when the cart was moving at constant speed.

5.
Zero the Force Sensor before collecting data.

a. Hold it so the working axis is horizontal.

b. With the Force Sensor axis held horizontally and no force applied, choose Zero from the Sensors menu. 

6.
Hold the Force Sensor in position, ready to pull the cart, but with no tension in the string.

7.
Start data collection. Wait a moment, then pull the cart as before, taking care to increase the force gradually. 

8.
Inspect your graph. Start data collection and repeat the process as needed until you have a graph that reflects the desired motion, including pulling the cart at constant speed once it begins moving. Sketch the graph for later reference.

Part II  Peak Static Friction and Kinetic Friction

In this part, you will measure the peak static friction force and the kinetic friction force as a function of the normal force on the block, as shown in Figure 1. In each run, you will pull the block as before, but by changing the masses on the block, you will vary the normal force on the block. 

9.
Remove all masses from the cart. 


10.
Using the same procedure as before, collect force vs. time data.


11.
To examine the data pairs on the displayed graph, tap any data point. As you tap each data point, the force and time values are displayed to the right of the graph. The maximum value of the force occurs when the cart started to slide. Read this value of the peak static friction force and record the number in your data table.


12.
Next you need to determine the average friction force while the block was moving at constant velocity.

c. Tap and drag your stylus across the approximately constant-force region to select the data points. 
d. Choose Statistics from the Analyze menu. The statistics for the selected region will be displayed.

e. Record the mean force value in your data table. 


13.
Repeat Steps 10–12 for two more measurements and average the results to determine the reliability of your measurements. Record the values in the data table.


14.
Add masses totaling 500 g to the cart. Repeat Steps 10–13, recording values in the data table. Add another 500 g and repeat.

Part III  Kinetic Friction Again

In this part, you will measure the coefficient of kinetic friction a second way and compare it to the measurement in Part II. Using a Dynamic Cart, you can measure the acceleration of the cart as it slides to a stop. This acceleration can be determined from the velocity vs. time graph. While sliding, the only force acting on the cart in the horizontal direction is that of friction. From the mass of the cart and its acceleration, you can find the frictional force and finally, the coefficient of kinetic friction.
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Figure 2


15.
Place the cart on the track near the Adjustable End Stop. Face the transmitter end of the cart toward the receiver at the end of the track. Position the reciever so that it will detect the motion of the cart as it slides toward the detector. Figure 2
 

17.
Practice sliding the cart toward the receiver so that the block leaves your hand and slides to a stop. After it leaves your hand, the cart should slide about 0.75 m before it stops and it must not come any closer to the receiver than 0.10 m.


18.
Collect data for the sliding cart. 

f. Start data collection.

g. After a moment, give the cart a brief push so that it slides toward the receiver.


19.
Inspect your graph. 

h. Examine the graph of velocity vs. time.

i. The velocity graph should have a portion with a linearly decreasing section corresponding to the freely sliding motion of the cart. Repeat data collection if needed. 


20.
Fit a straight line to this portion of the data, the slope of which is the cart’s acceleration.

j. Tap and drag across the region of linear decrease to select the data points.

k. Choose Curve Fit ►Velocity from the Analyze menu.

l. Select Linear as the Fit Equation to fit a straight line to the velocity data.

m. Record the magnitude of the slope of the fitted line, which is the carts’s acceleration, in your data table.

n. Select OK.


21.
Repeat Steps 18–20 two more times.


22.
Place masses totaling 500 g on the cart. Fasten the masses so they will not separate from the block. Repeat Steps 18–20 three times for the cart with masses. Record acceleration values in your data table.

Data Table

Part I  Starting Friction

	Mass of cart and force sensor
	kg


Part II  Peak Static Friction and Kinetic Friction
	Total mass
(kg)
	Normal force 
(N)
	Peak static friction
	Average
peak static friction 
(N)

	
	
	Trial 1
	Trial 2
	Trial 3
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


	Total mass 
(kg)
	Normal force
(N)
	Kinetic friction
	Average
kinetic friction
(N)

	
	
	Trial 1
	Trial 2
	Trial 3
	

	
	
	
	
	
	

	
	
	
	
	
	

	
	
	
	
	
	


Part III  Kinetic Friction

	Data: Cart with no additional mass

	Trial
	Acceleration
(m/s2)
	Kinetic friction force
(N)
	k

	1
	
	
	

	2
	
	
	

	3
	
	
	

	Average coefficient of kinetic friction: 
	


	Data: Cart with 500 g additional mass

	Trial
	Acceleration
(m/s2)
	Kinetic friction force
(N)
	k

	1
	
	
	

	2
	
	
	

	3
	
	
	

	Average coefficient of kinetic friction: 
	


Analysis

1.
Inspect your force vs. time graph from Part I. Label the portion of the graph corresponding to the cart at rest, the time when the cart just started to move, and the time when the cart was moving at constant speed.

2.
Still using the force vs. time graph you created in Part I, compare the force necessary to keep the cart sliding compared to the force necessary to start the slide. How does your answer compare to your answer to Preliminary Question 3?
3.
The coefficient of friction is a constant that relates the normal force between two objects (carts and track) and the force of friction. Based on your graph from Part I, would you expect the coefficient of static friction to be greater than, less than, or the same as the coefficient of kinetic friction?

4.
For Part II, calculate the normal force of the track on the cart alone and with each combination of added masses. Since the cart is on a horizontal surface, the normal force will be equal in magnitude and opposite in direction to the weight of the cart and any masses it carries. Fill in the Normal Force entries for both Part II data tables.

5.
Plot a graph of the maximum (peak) static friction force (y axis) vs. the normal force (x axis). on graph paper.

6.
Since Fmaximum static = s N, the slope of this graph is the coefficient of static friction s. Find the numeric value of the slope, including any units, by adding a Proportional Curve Fit. The Proportional Curve Fit passes through the origin.
7.
In a similar graphical manner, find the coefficient of kinetic friction k. Use a plot of the average kinetic friction forces vs. the normal force. Recall that Fkinetic  = k N. The Proportional Curve Fit passes through the origin.
8.
Your data from Part III also allow you to determine k. Draw a free-body diagram for the sliding cart. The kinetic friction force can be determined from Newton’s second law, or (F = ma. From the mass and acceleration, find the friction force for each trial, and enter it in the data table.

9.
From the friction force, determine the coefficient of kinetic friction for each trial and enter the values in the data table. Also, calculate an average value for the coefficient of kinetic friction for the cart and for the cart with added mass.


10.
Does the coefficient of kinetic friction depend on speed? Explain, using your experimental data.


11.
Does the force of kinetic friction depend on the weight of the cart? Explain.


12.
Does the coefficient of kinetic friction depend on the weight of the cart?


13.
Compare your coefficients of kinetic friction determined in Part III to that determined in Part II. Discuss the values. Do you expect them to be the same or different?

Extensions

1.
How does the surface area of the cart affect the force of friction or the coefficient of friction? Devise an experiment that can test your hypothesis.

2.
Examine the force of static friction for an object on an incline. Find the angle that causes a cart to start to slide. Calculate the coefficient of friction and compare it to the value you obtain when the angle of the incline is 0°.

3.
Try changing the coefficient of friction by using wax or furniture polish on the track. How much does it change?
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